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Chapter 1 

Universal ScatterProof Overview 

Kodak Polychrome Graphics Universal ScatterProof software makes it easy to assemble 
multiple digital files for output on a Kodak Approval RIP-A or Kodak Approval RIP  
HQ-1 System.  

 

SOFTWARE USER INTERFACE 

The Universal ScatterProof interface has three primary windows: 

• The Universal ScatterProof main window displays the active sheet(s). 

• The Library window lists processed files. 

• The Status window lists Assembly Folders (queues) and their status. 

 

WORKFLOW 

The basic workflow through ScatterProof is: 

1. Input files into ScatterProof 

– Manual or automatic mode 

2. Place files onto a sheet 

– Manual or automatic mode 

– Add cut marks, margins, data legend 

– Rotate, step and repeat, align 

3. Print the sheet as a Postscript file to an output folder 

 

An automatic workflow for Universal ScatterProof requires the following: 

• Input hot folder – The folder in which files are placed for input into ScatterProof. 

• Go criteria – User-defined conditions, such as number of elements per sheet, 
which determine when to automatically print an output file.  

• Output device or hot folder – The folder to which output files, ready for proofing 
on a Kodak Approval system, are written. 
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A manual workflow for Universal ScatterProof requires the following actions: 

• Open a new Sheet  

• Select Images (files) to scatter 

• Add files from the Library window to the Sheet 

• Edit the images on the Sheet, if necessary 

• Print the Sheet 

 

FILE TYPES 

The input file types are: 

• Postscript Level 2 or Level 3, composite or separated, including multi-page files 

• PDF version 1.4, including multi-page files (Acrobat 5) 

• PDF/X 

• EPS 

• DCS1 and DCS2 

• TIFF, including LZW support 

• TIFF/IT-P1 

 

The output file type is: 

• Postscript Level 3, composite or separated, determined by the input file type 

 

ADDITIONAL FEATURES 

• Color Mapping – Changes, or maps, the input separation name to a different 
output separation name. 

• Automatic determination of output file type (composite or separated) 
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Chapter 2 

Automatic Workflow 

OPEN THE APPLICATION 

1. Quit all virus software. 
2. Start Universal ScatterProof software by double clicking on the application icon.  

– If Universal ScatterProof has never been used, only the Main window opens. 
– If Universal ScatterProof is already running, close any Sheet windows open in 

the Main window. 

 
SET THE DEFAULT MEASUREMENT UNIT 

3. From the Configuration menu select Units -> Inches as the default measurement unit. 
The current default unit is indicated by a check mark in the menu. 

 

DEFINE THE CLEANING CRITERIA 

4. From the Configuration menu select Cleaning. Universal ScatterProof Cleaning 
options allow you to control how temporary files are managed. Cleaning is important 
because it ensures that enough disk space is available to process new files. Set the 
options as shown below: 

 

These cleaning options clean (delete)  
all temporary files associated with 
ScatterProof when the total disk space 
used exceeds 2 Gb.  

 

The cleaning occurs automatically when 
the ScatterProof program is quit.  

 

To clean files before quitting, click the 
Clean Now button. 

 

If you wish to delete files after they print, 
select the Delete input files when printed 
box. 
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SETUP THE ASSEMBLY FOLDER AND HOT FOLDERS 

5. On a local hard disk with at least 8 GB of free space, create two new folders and 
name them CompPS_in and CompPS_out.

6. From the File menu, select the command Universal ScatterProof -> Assembly Folder 
Setup. The Assembly Folder Setup window opens. (An Assembly Folder is like a 
queue.) 

7. Type CompPS in the ScatterProof Assembly Folder Name field 

8. Click on the drop down box in the ScatterProof Device field and select the Kodak 
Approval device that you have installed. 

9. Click the Output Setup button. Select FILE: in the printer field. Click OK.  

10. Navigate to and open the folder CompPS_out. The folder name and path appears in 
the Full Path field. Click OK. 

11. Next to Number of Copies, enter 1.  

12. Check the box labeled Save a TIFF Preview. This option creates a low-resolution 
preview of the sheet. It is used here to check output before proofing. 

13. Under Go Criteria, check all 3 boxes. Change 1 Element to 5, change 75% to 70%, 
and 15 minutes to 5 minutes. Leave the drop down box at First Of.  

14. In the Page Size area, select the Resolution of your Kodak Approval (2400 or 2540).  

15. Select Thin Horizontal for Control Strip. This option does not add a control strip to 
the output file. It establishes the height and width (page size) of the sheet. 

16. Set Element Margin to 0.25 inches. 

17. Leave the Sheet Margin at 0. 

18. Check Use Cut Marks. Set the Distance from Vertex for both horizontal and vertical 
to 0 (zero). 

19. In the Data Legend area, check the boxes for Include File Name and Include Date 
and Time. 

20. In the Global area, check Auto-Rotate Element to Fit. Do not select Optimize for 
Cutting or Step and Repeat. 

21. Check the Passthrough of oversize element box.  This will allow the application to 
move an oversized input file to the output folder location.  When not selected, 
oversized files must be manually placed in the output folder location. 

22. Do not check Double page spread.  This option should only be used when processing 
PS files that have been printed as double page spreads. 

23. Leave Color Map set to None. 

24. Click on Create/View Input Folder. 

25. Type CompPS_in in the Hot Folder Name field.  

26. Leave Dot Gain set to None. 
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27. Do not check the box for Load EPS as DCS layer. This box should be checked for 
Separated workflows only, especially when working with DCS files. 

28. Do not check the box for Use as Default Setup for Assembly Hot Folder. 

29. Leave File stabilization time set to 15 seconds. 

30. Click on the Hot Folder button. Navigate to and open the folder CompPS_in.
The folder name and path appears in the Full Path field. Click OK. 

31. The Input Hot Folder Setup should look like this: 

32. Click Save, then click Close. If you close without saving, all changes made to the 
Input Hot Folder Setup are lost. 

33. The Assembly Folder Setup should look like the screenshot below: 
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34. Click Save, then click Close. Your Assembly Folder (queue) is configured. 

 

RUNNING IN AUTO MODE 

35. Click on the Show/Hide Status icon in the toolbar . The Universal ScatterProof 
Status window opens. The Assembly Folder you just created, CompPS, is listed.  

36. Click on the Start Auto Mode button. When Automatic Mode is started, ScatterProof 
assembles elements on a sheet as soon as they have been processed and placed into 
the Library. 

37. Click once on the CompPS row to select it. Use the drop-down arrow in the Status 
column to select Start Hot Folders. Once the status reports Idle, the input hotfolder is 
active. When files are detected, they are processed and placed into the Library. 

38. Copy the following files from the Tutorial_Images/CompositePS folder on the 
ScatterProof CD to the CompPS_in input hotfolder: 

 ChildsPlay_comp.ps FANCYCAL_comp_2.ps 
 FANCYCAL_comp_1.ps WitchesPlay_comp.ps 

39. ScatterProof processes the files, and places them on the sheet. 

40. In the ScatterProof Status window, the status of the go criteria is displayed in red: 
– (#) number of elements added to the job,  
– (%) usage percentage, and  
– (time) time elapsed since the job started.  

41. When the go criteria are met, the sheet is printed to a Postscript file in the output 
folder CompPS_out. In this example, the go criteria are met after the fourth file is 
placed on the sheet. At that point, the sheet becomes more than 70% full. After 
printing the output PS file to the output folder, a new ScatterProof sheet opens, 
waiting for more input files. 
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42. Check your output file by viewing the TIFF Preview. The TIFF Preview is saved in 
the Plate Preview folder in the ScatterProof program folder. The name of the TIFF 
Preview file is the same as the PS file name (check the output folder for the name). 
Double click on the TIFF file to open it in an Image Accessory window. 

43. RIP and print the output PS file on your Kodak Approval system. To automate this 
step, set the ScatterProof output folder as the input hot folder for the RIP. 
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Chapter 3 

Manual Workflow 

The CompPS Assembly Folder, created in Chapter 1, is used in this chapter. However, 
any Assembly Folder can be used.  

Before you begin, copy the following folders and their contents from ScatterProof CD to 
your local disk: 

Tutorial_Images/CompositePS 
Tutorial_Images/SeparatedPS 

RUNNING IN MANUAL MODE 

1. In the Status window, click on the Stop Auto Mode button. Automatic placement of 
files to the sheet is stopped, and the input hot folder status is changed to Inactive. 

2. Close any Sheet windows open in the Main window of Universal ScatterProof. 

3. Click the New Sheet button in the toolbar. 

4. Select CompPS. Click OK. 

5. From the Image menu, choose Select Image. 

6. Navigate to the CompositePS folder on the local disk and select the file 
ChildsPlay_Comp.ps. Click Open.  

7. The file begins to process in ScatterProof. When processing is complete, the file is 
placed in the Library. 

 

THE LIBRARY WINDOW 

8. Click the right mouse button inside the Library window. Left-click on Detail. The 
Library window changes to a list view with details. Use the scroll bar, if necessary, to 
view the detail columns. 

9. Again, click the right mouse button in the Library window. Select Options. The 
Library options window appears. Check the box for Filename Only.  

10. Click OK. The File Name column changes to show filenames only, omitting the path. 

11. Double-click on the Library file ChildsPlay_Comp.ps. The file appears on the sheet 
in the main window.  
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MANIPULATING THE SHEET 

12. Click the Align Center button on the main toolbar. The file centers on the sheet. 

13. Click the Align Top Left button. The file moves back to the top left of the sheet. 

14. Click the Step & Repeat button. The file is duplicated as many times as possible 
to fill the sheet. 

15. Click on one of the files on the sheet to select it. Hit the Delete key on the keyboard 
to remove it from the sheet.  

16. Delete the remaining files.  From the Sheet menu select Clear. 

17. Add the file ChildsPlay_Comp.ps to the sheet and select it. 

18. Click the Rotate Image button. The image rotates 90 degrees. 

19. From the Image menu choose Select Image and select the file WitchesPlay_sep.ps 
from the SeparatedPS folder on the local disk. 

20. The file begins to process in ScatterProof. When processing is complete, the file is 
placed in the Library. 

21. In the Library window, double click on the WitchesPlay_sep.ps file. ScatterProof 
evaluates the first file placed on a sheet and determines its file type—composite or 
separated. Only files of the same type can be added to that sheet, until the sheet is 
printed. Each new sheet can be either composite or separated, depending on the first 
file added. Composite input files are output as composite Postscript. Separated input 
files are output as separated Postscript.  

22. Add the files FANCYCAL_comp_1.ps, FANCYCAL_COMP_2.ps and 
WitchesPlay_comp.ps to the sheet.  

23. Click the Rearrange button to automatically reposition pages on the sheet. 

24. Click the Zoom in button to enlarge the sheet view. 

Note: The preview of the data legend (filename, date and time) is for position only. 
The information that appears on the proof is accurate.  

 

PRINT THE SHEET 

25. Click the Print button to print the sheet. 
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Chapter 4 

Color Mapping  

HEXACHROME COLOR MAPPING EXAMPLE 

This chapter describes how to use the Color Mapping feature in Universal ScatterProof to 
map a Hexachrome digital file for proofing to a Kodak Approval.  

A Hexachrome digital file contains six separations names, as listed below in the Input 
Separation Name column. Color Mapping is used to map the Hexachrome separation 
names to Approval Donor names: 

 INPUT SEPARATION NAME OUTPUT SEPARATION NAME
Hexachrome Cyan � Process Cyan 

 Hexachrome Magenta � Process Magenta 
 Hexachrome Yellow � Process Yellow 
 Hexachrome Black � Process Black 
 Hexachrome Orange � Orange DO01 
 Hexachrome Green � Green DG01 
 

COLOR DATABASE 

1. Close any Sheet windows open in the Main window of Universal ScatterProof. 

2. From the Configuration menu, select the command Customize -> Color Mapping. 
The Color DB window opens. 
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INK DATABASE 

3. The Ink Database tab contains a list of color names. Use this tab to add a new color, 
modify a color, or remove a color from the list.  

4. To add a color name to the Ink DataBase: 

– Enter the color name in the name field at the top left of the window. 

– Enter a preview color in CMYK percentages. This color is used for preview 
in the Sheet window only, not for printing.  

– Click the Add Color button.  

– Ignore the Autotrap Settings section. It is not used in this version of 
Universal ScatterProof. 

 

5. Follow the instructions above to add the following colors: 

 COLOR NAME PREVIEW COLOR
Hexachrome Cyan 100 % Cyan 

 Hexachrome Magenta 100% Magenta 
 Hexachrome Yellow 100% Yellow 
 Hexachrome Black 100% Black 
 Hexachrome Orange 100% Yellow, 50% Magenta  
 Hexachrome Green 100% Yellow, 100% Cyan 
 Orange DO01 100% Yellow, 50% Magenta 
 Green DG01 100% Yellow, 100% Cyan 
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MAPPING 

6. The Mapping tab allows you to create color-mapping associations. 

7. To define a color-map association: 

– Select the input color name in the left column. 

– Select the output color name in the right column. 

– Click the Map button. 

 

8. Create the following color map associations: 

 INPUT COLOR NAME OUTPUT COLOR NAME (Mapped Color)
Hexachrome Cyan � Cyan 

 Hexachrome Magenta � Magenta 
 Hexachrome Yellow � Yellow 
 Hexachrome Black � Black 
 Hexachrome Orange � Orange DO01 
 Hexachrome Green � Green DG01 
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COLOR MAP 

9. The Color Map tab allows you to save a color map file. The color map file is used in 
the Assembly Folder setup. 

10. Before saving the color map file: 

– Verify that the list of mapped colors is correct.  

– If a color is incorrect, select the row, then click Delete. Click Yes at the 
warning.  

– If a color association is missing, go back to the Mapping tab and map it. 
Then return to the Color Map tab to verify that it was added. 

11. Save the Hexachrome color map file as Hex_Map.

– Click the Save as button. 

– Type a name (Hex_Map) in the File name field. (The default directory is 
ScatterProof\RESOURCE\Color Map. Do not change the path.) 

– Click Save. 

12. Close the Color DB window. 
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SETUP THE ASSEMBLY FOLDER 

13. From the File menu, select the command Universal ScatterProof -> Assembly Folder 
Setup. The Assembly Folder Setup window opens. 

14. In the ScatterProof Assembly Folder Name field, type SEP_HEX.

15. At the bottom of the window, select Hex_Map from the Color Map pull-down menu. 

16. Set the remaining options as shown below: 

SETUP THE HOT FOLDER 

17. Click on Create/View Input Folder. 

18. Type HEX_SEP_IN in the Hot Folder Name field.  

19. Check the box for Load EPS as DCS layer. Because this exercise uses DCS2 
(Hexachrome) files, this option is appropriate. 
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20. Set the remaining options as shown below: 

21. Click Save, then click Close. 

22. Save and Close the Assembly Folder Setup. 

23. Scatter one or all of the Hexachrome sample files from the folder Tutorial_Images/ 
Hexachrome on the ScatterProof CD.  You must copy the images from the CD to the 
hard drive.  Universal ScatterProof can not process files directly off of the CD. 
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Chapter 5 

Toolbar Shortcuts 

New allows you to select an assembly folder, then open a new sheet with those 
settings. (CTRL+N) 

Show/Hide Status opens and closes the Universal ScatterProof Status window. 

Print the current sheet. (CTRL+P) 

Rearrange the Plate automatically repositions pages by rotating them if necessary 
on the sheet while keeping track of landscape or portrait orientation on the press 
sheet. 

Rotate Image rotates the page 90 degrees clockwise so you can position it 
landscape or portrait. 

Align Top Left positions the page to the top left corner of the press sheet. 

Align Center positions the center of the page in the center of the press sheet. 

Step & Repeat lets you duplicate the selected page as many times as necessary to 
fill the press sheet. 

Select Trim Rectangle lets you select part of the page. The image area outside of 
the rectangle will be cropped. 

Repeat the Last Trim will duplicate the last completed trim function on a new 
page. 

Toggle lets you switch between the front and back of a duplexed press sheet. 

Show / Hide Grid will add or remove the visual grid defined in the plate layout 
settings. 

Library View shows or hides the Library window that contains the thumbnail 
view of RIPped documents. 

Zoom In lets you enlarge the image on the press sheet. (+) 

Zoom Out lets you reduce the image on the press sheet. (-) 

About opens the About Universal ScatterProof window. 
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